AutoCAD Training Agenda

Morning Session  - November 2, 2001


8:30 am     -      9:00 am
Set-up, Introductions

9:00 am     -      9:50 am
General Overview






Screen 






Menu







Toolbars







Command Line






<Play Time>


10:00 am    -    10:50 am
Open File






Directory Structure






Basic Draw






Basic Edit






<Play Time>


10:50 am    -    11:00 am
Break Time


11:00 am    -    12:00 pm
Print/Plot File






Paper Space/Model Space






<Play Time>


12:00 pm    -    1:00 pm
Lunch Break

1:00 pm     -      1:45 pm
Drawing Entities






Lines, Polylines 






Construction (Rays, Lines)






Modifying Entities



1:45 pm      -    2:15 pm
Student Time


2:15 pm    -    2:30 pm
Break Time


2:30 pm    -    3:30 pm
External Data






Xreferences






Blocks






Layers 






Plot/Paper Space/Model Space Review


3:30 pm    -    4:30 pm
Student Time
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General Discussion:

· There are many ways to execute commands

· Menu, Toolbars (docked/floating)

· Command Line

· F Keys

· Hot Keys

· Rt. Mouse

· Status Bar

· Menu Bars that display  > (arrow) hold and another menu will appear (MS Windows standard)

· Menu Bars that display  … (3 dots) will bring up a dialog box 

· Toolbars with > (arrow) denotes dropdown toolbar

· Underlined letters in menu or dialog boxes; use that letter as an abbreviation for the entire command word

· Information in <   > mean that is the default value and usually a return will activate the default command

· Read the Command Line – AutoCAD is constantly talking to you

F Keys:

F1
-
Help

F2
-
Text Window

F3
-
Osnap Settings (Right click OSNAP button on status bar, Pick Settings)

F4
-
***Tablet (not used)

F5
-
***Isoplane (Toggles isoplane: top, right, left)

F6
-
Coords On/Off (displays pointer coordinate location: left side status bar)

F7
-
Grid (Toggle On/Off)

F8
-
Ortho (Toggle On/Off)

F9
-
Snap (Toggle On/Off)

F10
-
Polar Tracking (Toggle On/Off)

F11
-
Object Snap Tracking (Toggle On/Off)

F12
-
***(not used)

AutoCAD Training Agenda

Morning Session  - November 2, 2001

Most Frequently Used Menu Commands:

File

->
New…




Open…




Close




Save




Save As…




Plot…




Exit

Edit

->
Undo




Cut
Ctrl+X




Copy
Ctrl+C




Paste
Ctrl+V

View

->
Regen

Zoom >




Pan >




Toolbars…

Insert

->
Block…




External Reference…




Layout >

Format
->
Layer…




Color…




Linetype…




Text Style…

Tools

->
Inquiry > Distance/Area/List




Properties…
Ctrl+1




Drafting Settings…




Options…

Draw

->
Line




Polyline




Polygon




Rectangle




Hatch…




Text >
Multi Line Text…/Single Line Text

Dimension
->
Linear




Angular




Leader




Tolerance…

Modify
->
Properties…
(2nd occurrence in menus)




Match Properties




Object >




Erase




Copy




Mirror
(do not use, creates drawing integrity problems)




Offset




Array…




Move




Rotate




Scale




Stretch



Trim




Extend




Chamfer




Fillet




Explode

Window
->
Close…




Close All…




1. Drawing1.dwg…etc.




Image

->
Not commonly used.

Map

->
For Advanced CAD users…

Help

->
Autodesk Map Help F1

Today




What’s New




Tutorials




AutoCAD Learning Assistance




AutoCAD Support Assistance

Toolbar Discussion: See handout
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Command Aliases “HOT KEYS” 

Hot Keys denoted in Italics are not standard AutoCAD hot keys.

Minus symbol preceded hot keys activate command line response, not dialog box interface.

KEY
COMMAND
                       DESCRIPTION

A
arc

for drawing arcs

AA
area

gives area of boundary

AP
appload   
loads other applications to the current session of ACAD

AR
array  

arrays entities, either polar or x,y

AT
ddatte 

used to edit and define block attributes

-AT
attdef

change attribute definition

BC
blkcount
gives total # of blocks based on name

BL
blklayer
routine that changes furniture blocks to correct layer

BM
blipmode
toggles blipmode on/off

BP
boundary
creates a closed polyline (once the bpoly command)

BS
blockshow
allows block name to be entered and displays image

BP
bpoly

boundary command, makes closed polyline

C 
copy

for copying objects

CH
ddchprop
changes layer, linetype, & color of multiple entities

CI
circle

for drawing circles

CR
copyrot
copy and rotate entities

D
dist  

displays distance between two user defined points


DA
ddatte

modifies attribute in block

E
erase 

erases any entity

ED
ddedit
 
edits text strings one at a time

EX
extend 

extends lines to a user defined edge

F
fillet 

connects the ends of two lines

GS       greensheet       runs the greensheet command to count and value blocks

H
dialog box
Herman Miller + fur symbols

I
ddinsert
insert blocks 

L
line 

starts the "line" command

LI
list

lists entity data of selected objects

LA
ddlmodes 
layer control dialogue box

LC
laychg

pick object on layer you want next object to go on

LE
leader 

text leader, arrow point first, then line to text

LF
layfrz

pick entity on layer that you want to freeze

LS
layset

sets current layer by picking object on a specified layer

LO
layoff 

turns layer off by selecting an entity

LL
laylock     
locks layer by picking object on that layer

LU
unlock 

unlocks layer by picking object on that layer
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Command Aliases “HOT KEYS” 

Hot Keys denoted in Italics are not standard AutoCAD hot keys.

Minus symbol preceded hot keys activate command line response, not dialog box interface.

KEY
COMMAND
                       DESCRIPTION
MI
mirror 

mirrors any entity

MO
ddmodify 
will modify and change any entity (very powerful)

MR
moverot
move and rotate entities
MS
modelspace
standard drawing environment

MT
mtext

allows paragraph of text to be entered

O
offset 

offsets entity to a user defined distance

P
pan 

pans display from a point to a point (dynamic)

-P
pan

pans display from a point to a point (command line)

PL
polyline 
starts polyline command

PS
paperspace
for plotting

R
rotate 

rotates entities

RC
rectang 
draws a rectangle from two corner points

RD
redraw 
redraws the current screen

RG
regen 

regenerates the entire screen

S
stretch 

stretches an entity 

SC
scale 

scales any entity

SR
script

runs a select script file (macro)

SS
sstretch
runs a stretch command where entity selection is improved

ST
style

create/modify text styles

T
dtext 

dynamic text, displays on screen as you type it

TR
trim 

will trim a line using another line a cutting edge

W
wblock

creates a wblocked drawing from existing data

X
explode
explodes blocks into elements

XL
xline 

construction lines ( display only , will not plot )

Z
zoom 

zoom window 

AutoCAD Training Agenda

Morning Session  - November 2, 2001

AUTOCAD PLOT SHEET





Paper Size:


Printable Area:


ANSI A
8.5" X 11"


7.16" X 10.6”



ANSI B
11"  X 17"


9.66" X 16.60"



ANSI C
18" X 24


15.66" X 21.60"



ANSI D
24" X 36"


20.66" X 33.60"



ANSI F
28” X 40”


27.60” X 38.66”



ANSI E
36" X 48"


33.60" X 42.66"

Model Space Plotting:


Scale        Plot Inch=Dwg Units
Plot Inch=Dwg Units       Zoom Factor

[Arch]




[AutoCAD Plot Box]
       [Paper Space]


1
 
    1" = 1'


1 = 12


1/12xp


3/4

  3/4" = 1'


1 = 18


1/18xp


1/2

  1/2" = 1'


1 = 24


1/24xp


1/4

  1/4" = 1'


1 = 48


1/48xp


3/16

3/16" = 1'


1 = 64


1/64xp


1/8

  1/8" = 1'


1 = 96


1/96xp


3/32

3/32" = 1'


1 = 128

1/128xp


1/16

1/16" = 1'


1 = 192

1/192xp

Paper Space Plotting:


Plot Paper Space layouts with scale set to 1 : 1


(View port scale dictates output plot scale).

Note: In Paper Space each view port, within the layout, can have a separate view port scale set.


Plot Paper Space layouts “Scale to Fit”, if scale is not an issue.

Lunch Break: 12:00pm – 1:00pm, Please be on time.

 AutoCAD Training Agenda

Afternoon Session – November 2, 2001

Entities – are objects like Lines, Circles, Arcs, Rectangles, Text, blocks, External References, etc.  Entities have properties that define how the entity looks and behaves.

Basic Objects (DRAW Commands):

· Line 

Initiate the Line command 

Pick a point to start (use snaps or give an  xy coord for specific placement)

Place cursor in direction of line and 

pick end point (use snaps and/or Ortho controls)  or 
enter distance (i.e. 20’) or

enter relative point and angle (i.e. @5’<45)

· Polyline (aka Pline)

Created the same way as line command but the segments are joined as one entity.  Can include arcs, have a width factor, and close to form an area.


· Polygon (square, triangle, octagon…..)

Many sided object with sides of equal length

Initiate Polygon command

Enter number of sides (1-1024 sides)

Pick center point

Select (I)nscribed or (C)ircumscribed.  Inscribed means the whole polygon will fit within the outer boundary of the second pick versus tangent to a circle.

· Circle

Initiate Circle command 

Select method of circle: 3P (using 3 points); 2P (using 2 points); TTR (tangent); <Center Point>  Center is most common

· Arc

Initiate Arc command 

There are many choices to this command with multiple points and starting/stopping points. Please read and respond as needed.  Further info can be obtained through the online help or asking a CAD operator.

AutoCAD Training Agenda

Afternoon Session – November 2, 2001

Other Lines or Construction Tools (more DRAW commands):

· Multiline – (aka Mline) a multiple line segment with a defined offset (scale).  Use MLedit command to modify intersections.

· Ray  - a continuous line beginning at a selected point and extending infinitely 


· Construction Line – a continuous line created by selecting the mid-point and going indefinitely in both directions

The Zoom Extents command ignores infinite Rays and Construction Lines.

Modifying Elements (MODIFY commands):

· Offset  - creates a duplicate entity at a defined distance.

· Array – Multiple offset of an object horizontally and/or vertically.


· Erase – gets rid of an object (may not get rid of all properties or definitions)


· Copy – copy one or multiple object(s) using a base point as a pickup point


· Move – move an object(s) position from one place to another using a base point


· Rotate – take an object and alter its orientation around a base point


· Scale – make an object larger or smaller based on a base point and scale factor or reference


· Trim – select the cutting object and then select the object to be cut


· Extend – select the object to extend to then select the object to extend

· Break – breaks a line/polyline into two separate lines/polylines.

· Fillet – make two objects extend and meet at their apparent intersection


· Properties – changes the ‘description’ of an object
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External Data (INSERT Commands)

Two major approaches to sharing data with other CAD drawings are Blocks and External References (Xref).  

The characteristics of a Block are:

· ‘inserted’ into a drawing

· static object (they do not change as the original changes)

· permanently part of the new drawing

· can have attributes that are modifiable

· position is typically placed manually

Block Attributes – Blocks that have special attributes can be modified.  (Modify; Object; Attribute or use the AT hotkeys).  Select the object and type in the changes.


The characteristics of an Xref are:

· visual ‘links’ to other CAD drawings

· dynamic object – if original drawing changes data is refreshed when reopened

· temporarily part of the new drawing (only link is saved reducing file size)

· supports the draw it once and use it many concept

· no modifiable data

· position is almost always inserted at 0,0 (zero X, zeroY coordinate)

Xref Attach vs Overlay – An Attached Xref will be present/visible if the current drawing is referenced, an overlayed drawing will not.

Attached:  Drawing A (----- Drawing B (-------- Drawing C

Overlay:    Drawing A (----- Drawing B


Xrefs should never be Erased !!!  If you will no longer need the Xref, detach the drawing through the Xref manager.
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Layers

Layers are used to control groups of data.  Common controls for layers are:

· Name  -  <Description> Unique alpha/numeric identifier for the layer.

· On/Off  -  <Light Bulb> Makes objects on layer visible or not.  It is not recommended to use this function – use the Freeze/Thaw option!

· Freeze/Thaw - <Sun/Snowflake> Makes objects on layer visible or not and removes them from the drawing database.  This will make help make routines faster as it does not have to search through as much data.

· Freeze/Thaw Viewports - <Sun/Snowflake/Box> This is only available if you use viewports and/or paperspace

· Lock/Unlock - <Padlock> This controls the selection ability of an object.  The data is visible but it cannot be selected or modified.

· Color <color box> All objects on this layer will be displayed the Layer Color unless the objects color has been set.

· Linetype - <line example> All objects (lines, plines, circles, etc.) will be displayed using the Layer Linetype unless the objects linetype has been set.

· Lineweight - <line thickness> Default line weight is plotted unless re-assigned here. 

· Plot Style - <alternate pen assignment> Default color/pen is plotted unless re-assigned. Then the layer plots with an assigned color/pen independent of the display/screen color.

· Plot - <layer active/inactive plot> Plotting individual layers may be turned on or off.

Characteristics of Layers:

A ‘current’ layer is selected (see menu bar for current layer info).  Objects that are inserted or xref'd will go on the ‘current’ or active layer.

Create a new layer X-______ for xreferences.  This will allow the entire xref to be frozen or thawed in one step.

Xref Layers are depicted by the Drawing Name, a vertical bar, then the layer name.  [For example, R1U-BLD|b-doors].  If you freeze this layer, all data on this layer will become invisible.

Layer Names can be Alpha (A-Z) or Numeric (0-9) and include a dash (-) or an underscore (_).  Our layer naming convention is:

AAA-BBBBBBBB


Where AAA denotes the discipline and BBBB is the description

Layer Translator: 

From the menu bar: Tools -> CAD Standards -> Layer Translator
A drawing translation tool for converting multiple layer names to a new set of standard layer names. The translator is based on a 1:1 or many to 1 layer conversion process.  
Notes:
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